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1ГГГГГлавалавалавалавалава

Д
ля начала давайте с вами разберемся со всеми достоинствами этой
ОС. К сожалению, большинство пользователей не знают даже части
самых ценных новаций в Windows XP. Поэтому прежде предлагаю по$
смотреть, что же нам предложила Microsoft.

Совместимость (Compatibility)Совместимость (Compatibility)Совместимость (Compatibility)Совместимость (Compatibility)Совместимость (Compatibility)
Система может иметь привычный интерфейс ОС семейства Windows, с неко$
торыми добавлениями и расширениями, поддержку файловых систем NTFS5,
NTFS4, FAT16 и FAT32. Большинство приложений, написанных под MSDOS,
W9x, NT4, а также некоторые программы под OS/2 и POSIX, запускаются и
функционируют без проблем. При проектировании NT учитывалась возмож$
ность работы системы в различных сетевых средах, поэтому в поставку входят
средства для работы в Unix$ и Novell$сетях.

Переносимость (Portability)Переносимость (Portability)Переносимость (Portability)Переносимость (Portability)Переносимость (Portability)
Система работает на различных процессорах семейства x86 производства
Intel и AMD. Уже существует 64$битная версия WindowsXP и Windows.NET,
предназначенная для работы на Intel Itanium. Реализация поддержки процес$
соров других архитектур возможна, однако потребует некоторых усилий.

Масштабируемость (Scalability)Масштабируемость (Scalability)Масштабируемость (Scalability)Масштабируемость (Scalability)Масштабируемость (Scalability)
В WindowsXP реализована поддержка технологии SMP. В Windows.NET Advan$
ced Server и Datacenter Server, кроме этого, есть поддержка COW (Cluster Of
Workstations).

Основная информацияОсновная информацияОсновная информацияОсновная информацияОсновная информация
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Система безопасности (Security)Система безопасности (Security)Система безопасности (Security)Система безопасности (Security)Система безопасности (Security)
Реализована привычная для NT система безопасности на уровне пользователей.

Распределенная обработка (Distributed processing)Распределенная обработка (Distributed processing)Распределенная обработка (Distributed processing)Распределенная обработка (Distributed processing)Распределенная обработка (Distributed processing)
WindowsXP имеет встроенные в систему сетевые возможности. Это обеспечи$
вает возможность связи с различными типами компьютеров$хостов благодаря
наличию разнообразных транспортных протоколов и технологии «клиент—
сервер».

Надежность и отказоустойчивостьНадежность и отказоустойчивостьНадежность и отказоустойчивостьНадежность и отказоустойчивостьНадежность и отказоустойчивость

(Reliability and robustness)(Reliability and robustness)(Reliability and robustness)(Reliability and robustness)(Reliability and robustness)
Архитектура ОС защищает приложения от повреждения друг другом и самой
операционной системой. При этом используется отказоустойчивая структури$
рованная обработка особых ситуаций на всех архитектурных уровнях, кото$
рая включает восстанавливаемую файловую систему NTFS и обеспечивает за$
щиту с помощью встроенной системы безопасности и усовершенствованных
методов управления памятью.

Локализация (Localization)Локализация (Localization)Локализация (Localization)Локализация (Localization)Локализация (Localization)
Система предоставляет возможности для работы во многих странах мира на
национальных языках, что достигается применением стандарта ISO Unicode.

Расширяемость (Extensibility)Расширяемость (Extensibility)Расширяемость (Extensibility)Расширяемость (Extensibility)Расширяемость (Extensibility)
Благодаря модульному построению системы становится возможным добавле$
ние новых модулей на различные архитектурные уровни ОС.

РазноеРазноеРазноеРазноеРазное
Следующий немаловажный вопрос, который может возникнуть у человека,
вполне логичен. Звучит он следующим образом: «Какой build финальный? Как
точно узнать версию XP? Как отличить пиратский релиз от настоящего?»

Финальный билд$2600. Узнать его можно либо командой winver, либо по
версии ядра ХР, например файла ntoskrnl.exe. Отличить пиратский релиз от
настоящего стало еще проще, чем в какой$либо другой Windows, благодаря ме$
ханизму активации (Windows Product activation), встроенному в систему. В пи$
ратском релизе должны быть включены средства борьбы с ней, поэтому если
вы увидите папку с названием crack или чем$то вроде этого, то можете быть
уверены, что релиз пиратский. Если на вашем диске нет ничего подобного,
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а сам диск имеет все признаки нелегального (нет голограммы, лицензионного
соглашения на бумаге, отсутствует наклейка, которая меняет цвет, если на$
греть ее пальцем), то вы рискуете тем, что эта версия перестанет работать
в течение месяца. Впрочем, есть и «ломаные» пиратские релизы, которым не
нужны регистрации вообще. Кроме этого, существуют так называемые корпо$
ративные релизы, сделанные Microsoft для своих крупнейших OEM партне$
ров. Такие релизы не требуют регистрации изначально. К сожалению, в связи
со сложившейся ситуацией в нашей стране люди сознательно берут пиратские
диски, поэтому им может быть и все равно, какая у них версия и т. д., но вот
пользователям, желающим приобрести лицензионный вариант, следует отнес$
тись к этому внимательнее!

В Windows XP есть опция Windows Product Activation, с ней вам придется
столкнуться либо разу после установки, либо в течение месяца.

Это новая технология, разработанная Microsoft для борьбы с нелегальными
копиями их программного обеспечения. Впервые подобный механизм был
опробован на Terminal Service, из W2k Server, теперь же, похоже, подобным
образом будут защищаться многие последующие продукты Microsoft. Суть тех$
нологии состоит в следующем: после инсталляции системы на основе серий$
ного номера, который дается с каждой копией XP, и некоторых особенностей
вашего компьютера генерируется так называемый Product ID. Он состоит из
20 цифр, и на его основе (вместе с правильным серийным номером конечно
же) вы получаете Activation Code, после введения которого Windows считается
активированной. Как утверждает Microsoft, на основе этих двух номеров они
не могут узнать ничего про ваш компьютер. То есть полная анонимность. Если
не проделать такой процедуры, то через 30 дней в XP просто перестанет функ$
ционировать все, кроме апплета, отвечающего за активацию. Проводить акти$
вацию на одном и том же компьютере можно сколько угодно. Product ID на
одной и той железке всегда будет одинаковый, поэтому вы безбоязненно може$
те переставлять систему столько раз, сколько захотите. Activation Code, кото$
рый вы получили один раз, будет подходить всегда. Вне зависимости от того,
какой из способов активирования вы использовали.

Узнать, активирована ли ваша версия XP, можно в окне System Summary, на$
ходящемся в меню Programs → Accessories → System tools → System Informa�

tion (Программы → Стандартные → Служебные → Иноформация о системе).
Если увидите строку Activation Status (Статус активации) и напротив нее

надпись вроде Activation Pending (активации) (XX days remaining (XX дней
осталось)), значит, через XX дней ваша XP перестанет работать. Апплет, кото$
рый отвечает за активацию XP, находится в меню Programs → Accessories →
System Tools → Activate Windows (Программы → Стандартные → Служеб�

ные → Активация продукта). При запуске этого апплета откроется простой
визард, который предложит зарегистрировать свою копию XP через Ин$
тернет либо по телефону. После того как система будет активирована (любым
способом), строка Activation Pending из System Information пропадет без следа
(рис. 1).
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Теперь переходим к вопросу видов поставок XP. Первоначально выпущены
две версии – Windows XP Home Edition и Windows XP Professional. Кроме
этого, существует 64$битная версия Windows XP Professional, сделанная для
64$битного Intel Itanium. Позже будут выпущены Widows.NET Server, Windows.NET
Advanced Server и Windows.NET Datacenter Server (x86 и 64 bit edition для каж$
дого). XP Home позиционируется как ОС на смену линейки W9x (хотя не име$
ет с ней ничего общего), XP Professional – как смена для Windows2000 Professio$
nal. Из существенных отличий между ними можно отметить только отсутствие
поддержки SMP в XP Home. Но, несмотря на это, даже XP Home построена на
ядре и по идеологии NT, поэтому с 25 октября 2001 года (дата официального
выхода XP) можно говорить о давно обещанной официальной смерти линейки
W9x и идеологии MS$DOS вместе с ней. Windows.NET отличается от XP нали$
чием системных служб и приложений, свойственных серверу, и поддержкой
более мощного железа. Так, если XP Pro поддерживает SMP только на два про$
цессора, то NET Server – уже на 4, NET Advanced Server – на 8, а NET Datacenter
Server – на 32.

На мой взгляд, каждый уважающий себя пользователь должен знать, какие
минимальные системные требования необходимы Windows XP, это относится
к разряду must know!

Microsoft утверждает, что для успешной инсталляции XP необходим процес$
сор не менее 233 МГц, 64 Мб оперативной памяти и 1,5 Гб свободного места на
диске. Однако для более$менее комфортной работы понадобится процессор не
менее 500 МГц и не менее 128 Мб оперативной памяти. Хотя, максимально

Рис. 1  Системная информация
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облегчив интерфейс, можно добиться того, что XP будет требовать меньше
памяти, чем W2k, поэтому если пожертвовать всякими «примочками» и ви$
зуальными эффектами, то вполне комфортно можно будет работать и на ме$
нее мощных системах. Вообще, если на машине работает W2k, то будет рабо$
тать и XP, ничуть не хуже, если даже не лучше. Как и любая ОС на ядре NT, XP
очень любит лишнюю оперативную память, поэтому 512 Мб для такой систе$
мы желательны, хотя и не обязательны. На 256 Мб система работает очень
быстро и достаточно приятно, если не грузить ее слишком тяжелыми прило$
жениями. Если включить все визуальные эффекты, то XP будет заметно при$
тормаживать на относительно слабых процессорах, вне зависимости от объе$
ма оперативной памяти. Такой же эффект наблюдается при использовании
слабой видеокарты. Однако если система достаточно мощная, то нормально
настроенная XP будет работать гораздо быстрее, чем любая ОС от Microsoft,
выпущенная ранее.

Теперь о совместимости со старым программным обеспечением.
Как и в W2k, ядро NT накладывает свои ограничения, поэтому нельзя ожи$

дать от XP абсолютно полной совместимости со старым программным обеспе$
чением. Однако по сравнению с w2k ситуация с совместимостью несколько
улучшилась. Из наиболее заметных изменений можно отметить появившийся
звук в старых ДОСовских играх, чего было весьма сложно добиться в W2k.
Поддерживается эмуляция Sound Blaster 2 и General MIDI, так что теперь мож$
но без плясок с бубном и сторонних утилит заставить работать со звуком такие
старые хиты, как Worms, Duke Nukem 3D, Warcraft 1 и 2, Dune 2. Кроме этого,
в XP встроен режим совместимости со старыми ОС. Чтобы его задействовать,

необходимо создать ярлык (shortcut)
на проблемную программу и выбрать
закладку Compatibility из Properties яр$
лыка. В этой закладке можно указать,
под видом какой ОС требуется запус$
кать программу, надо ли менять раз$
решение или глубину цвета при этом
(необходимо для многих старых прог$
рамм) (рис. 1a).

В отличие от acompat.exe из дистри$
бутива W2k, XP в режиме совместимо$
сти не просто рапортует программе,
что она – это не она (по типу старой
утилитки из MS$DOS под названием
setver), но и эмулирует структуру реест$
ра Windows, свойственную той или
иной версии ОС. Если нет желания ла$
зать по свойствам файлов и ярлыкам са$
мостоятельно, можно воспользоваться
Program Compatibility Wizard из кнопкиРис. 1а  Окно совместимости
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Start → Programs → Accessories. Впрочем, не стоит ожидать от этого механиз$
ма чуда, 100%$ой совместимости добиться так и не удалось, поэтому не будет
лишним сходить на сайт производителя вашей программы и посмотреть, не
появился ли там апдейт, делающий ее совместимой с XP.

Бывалые пользователи наверняка помнят о DLL$hell. Сколько мучений
с этим было…

Данной проблеме было уделено самое пристальное внимание. Причем
к этому вопросу подошли более комплексно, чем когда$либо до этого. Во$пер$
вых, никому не дадут просто так перезаписать какой$либо DLL в системной
директории. Кроме этого, остался знакомый нам по W2k механизм SFC, System
File Protection. Эта система мониторит основные системные файлы и в случае
замены какого$либо из них меняет все обратно. Кроме этого, в Microsoft поче$
му$то позаботились о криворуких программистах, которые не могут писать
нормально и которым обязательно надо, чтобы их творение работало с соб$
ственными DLL, подменяющими системные. При инсталляции такой про$
граммы эти переделанные DLL все$таки будут записываться на диск, но не вме$
сто системных. Потом, при запуске данной программы, в случае вызова DLL
должен вызываться не системный файл, а заранее сохраненный файл именно
от этой программы. Хранятся эти DLL в подкаталоге WinSxS, что означает
Windows Side by Side (бок о бок), что весьма символично.

Многих мучит вопрос: «Что такое Dynamic Disk?» Попробую дать исчерпы$
вающий ответ.

Это физический диск, на котором могут быть созданы динамические разде$
лы. Такой диск может быть доступен только из W2k или XP. Динамические раз$
делы могут быть следующих видов.

1. Простые (simple). Они практически ничем не отличаются от тех, к ко$
торым мы привыкли.

2. Составные (spanned). Состоят из нескольких динамических дисков, ко$
торые представлены как один диск. Данные пишутся и читаются после$
довательно.

3. Чередующиеся (stripped). Несколько динамических дисков, которые
представлены как один диск. Данные пишутся и читаются одновременно
с нескольких дисков. Теоретически это должно обеспечивать вдвое боль$
шую скорость на дисковых операциях. На практике прирост хотя и значи$
тельный, но меньше, чем в два раза. Я бы рекомендовал использовать этот
режим только в том случае, если уже имеются два диска. В противном слу$
чае гораздо выгоднее купить один винчестер вдвое большего объема,
с отличными скоростными характеристиками, чем два маленьких и более
медленных, в расчете на то, что они будут быстрее. Конечно, если взять
два быстрых диска и объединить их в Stripped Volume, то они будут быст$
рее, чем один. Однако системный раздел не может быть Stripped Volume.
В этом случае разумнее приобрести аппаратный IDE$RAID контроллер,
который обеспечивает возможность работы с RAID даже из$под ДОС; та$
ким образом можно сделать системный раздел чередующимся.
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4. Зеркальные (mirrored). Эти разделы состоят из двух физических дис$
ков. Данные, записываемые на один из дисков, автоматически дубли$
руются на другом. Это не дает никаких преимуществ в плане скорости,
но зато обеспечивает вдвое большую степень надежности сохранности
данных.

5. RAID5. Состоит из трех или более дисков. Представляет из себя stripped
с контролем ошибок. То есть данные пишутся на два диска, в два блока,
а на третий диск и в третий блок записывается ECC, код коррекции оши$
бок, с помощью которого по информации любого из блоков можно вос$
становить содержимое второго блока. Причем код ECC записывается
попеременно, на каждый из входящих в массив дисков. Эта технология
позволяет более экономно использовать дисковое пространство, чем
mirrored volumes, но работает медленнее. Любой из этих разделов мо$
жет быть отформатирован как под FAT32, так и под NTFS. Управление
Dynamic disk осуществляется через раздел Disk Management окна Com$
puter Management.

Примечание. Все эти разделы, кроме simple, можно создавать только на динами�
ческих дисках.

Обычный диск может быть конвертирован в динамический из окна Disk
Management, однако обратный процесс (конвертировать динамический диск
в простой) не всегда возможен. Например, если диск с самого начала создавал$
ся как динамический, то на нем отсутствует привычная таблица разделов, и
чтобы создать ее, придется заново разбивать его с помощью fdisk и формати$
ровать. Кроме этого, если удалить на динамическом диске несколько парти$
ций, то свободное место не объединяется и новая партиция, равная по разме$
ру удаленным, будет состоят из нескольких мелких партиций, объединенных
в volume set под одной буквой.

TTTTTask Managerask Managerask Managerask Managerask Manager
Task Manager – это один из самых мощных и удобных инструментов в NT, пред$
назначенных для управления процессами. Вызывается он либо Ctrl+Shift+Esc,
либо выбором в меню, появляющимся после нажатия правой кнопкой на
Taskbar’е. Task Manager в XP состоит из пяти закладок – Applications, Processes,
Performance, Networking и Users. Начнем с Performance.

На этой закладке показывается информация о загрузке процессора(ов)
в реальном времени (зеленым цветом – процессы пользователя, красным –
системные процессы), показывается загрузка физической памяти, причем по$
казано, сколько занято/свободно оперативной памяти и сколько занято сис$
темного Swap’а. Кроме этого, дается другая дополнительная информация, на$
пример Threads и Processes – количество нитей и процессов, исполняемых
сейчас на машине, Peak – пиковый размер Swap’а в течение сессии, Nonpaged –
количество памяти, отведенное под ядро. Эта информация может использо$
ваться, когда надо будет ответить на вопрос, какой фактор в системе является
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«бутылочным горлышком», замедляющим работу (хотя для подобных целей
лучше использовать Performance Monitor).

Вторая закладка, Processes, содержит список процессов, активных в дан$
ный момент.

Для каждого процесса можно узнать некоторую дополнительную информа$
цию, как то: PID (Process ID), количество используемой оперативной памяти,
количество нитей, сгенерированных процессом, и многое другое. Из полез$
ных дополнений, которые появились в XP, следует отметить появившийся
столбик User Name. В нем можно узнать, какой пользователь или системная
служба запустили тот или иной процесс. Добавить/удалить показываемые па$
раметры можно через View → Select Columns.

Кроме этого, с любым из данных процессов можно произвести определен$
ные действия. Для этого надо просто нажать на нем правой кнопкой мыши,
появится контекстное меню, через которое можно закончить («убить») про$
цесс (End Process); также можно убить как сам процесс, так и все остальные,
которые он «породил» (End Process Tree). Можно выставить приоритет про$
цессу от высшего Real$Time до самого низкого Low. Если на машине установле$
ны два процессора и многопроцессорное ядро, то в этом меню появляется еще
один пункт, Set Affinity, который позволяет перевести процесс на другой про$
цессор, Cpu 0, Cpu1 и т. д. до Cpu31.

Закладка Applications позволяет просмотреть список работающих прило$
жений и «убить» любое из них. Task Manager позволяет не только «убивать»
приложения, он может также запускать новые приложения: File → New task

(Run...). Иногда это бывает очень полезно. Например, если по какой$либо при$
чине зависнет интерфейс пользователя, то его можно с легкостью «убить»
(процесс explorer.exe), а после стартовать заново. Причем это не обязательно
должен быть explorer.exe. Можно, к примеру, запустить progman.exe и полу$
чить интерфейс, подобный интерфейсу W3.1, или же любой из внешних ин$
терфейсов, которые в изобилии можно найти на просторах Интернета.

Закладка Networking. Эта одна из закладок, которая появилась в Task
Manager только в XP. На ней показывается загрузка локальной сети.

Закладка Users. На ней можно посмотреть пользователей, которые в дан$
ный момент работают на машине. Если у вас имеется достаточно прав, то вы
можете отключить этого пользователя или просто послать ему сообщение.
Подобные вещи давно и широко используются в самом различном программ$
ном обеспечении, предназначенном для управления многопользовательскими
системами, но именно в Task Manager эта возможность появилась впервые.

ИнтерфейсИнтерфейсИнтерфейсИнтерфейсИнтерфейс
После достаточно долгого перерыва Microsoft существенно меняет внешний
вид своих ОС. Основные принципы работы интерфейса остались прежними,
но всяких мелких, и не очень, изменений и улучшений просто огромное коли$
чество. Первое, что бросается в глаза, – это изменившееся оформление систе$
мы. На смену строгим ровным линиям без лишних «украшательств» пришли
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округлости, мягкие полутона и тени. Вообще$то Microsoft не изобретала «вело$
сипед», многие тенденции, которые нашли свое воплощение в новом оформ$

лении XP, мы могли видеть и раньше, в том числе и на PC. Как и W2k, использо$
вавший цветовую гамму, впервые появившуюся в KDE 1.2, XP использует

элементы цветовой гаммы и оформление некоторых элементов интерфейса
(например, скролл$бары), сходные с используемыми в KDE. Если кому не нра$

вятся новые веянья в «компьютерной моде», он легко может привести внеш$
ний вид системы в более привычный, такой как у W2k или W98.

AntialiasingAntialiasingAntialiasingAntialiasingAntialiasing

Этот метод сглаживания шрифтов делается в Display Properties, закладка Ap$

pearance, кнопка Effects... Надо поставить галочку напротив Use following me$
thod to smooth edges if screen font.

Выбрав Standard, вы включите стандартную поддержку АА, которая была
в ОС от Microsoft еще со времен W95. Включается она при большом размере фон$

тов, поэтому в повседневной работе мало чем отличается от полного отсутствия
АА. Выбрав ClearFont, вы задействуете технологию, изначально придуманную

Microsoft для LCD экранов и ранее используемую в Windows CE. Этот метод пре$
красно показывается на современных CRT мониторах и дает реальный AA, при$

чем везде, во всех приложениях, всех окошках и т. д. Выглядит это так:
� Нормальные шрифты

� Clеar Type шрифты
Того же эффекта можно добиться и через реестр, HKEY_USERS\.DEFAULT\

Control Panel\Desktop, присвойте ключу FontSmoothingType значение 1 – если
хотите Standard AA, 2 – если хотите ClearType, и оставьте 0 – если ничего не

хотите. Но в последнем случае придется перезагрузить компьютер.

Настройка TНастройка TНастройка TНастройка TНастройка Taskbar и Start Menuaskbar и Start Menuaskbar и Start Menuaskbar и Start Menuaskbar и Start Menu
Все богатство настроек Taskbar вызывается через правый клик на таскбаре,
пункт Properties.

На первой закладке, Taskbar, имеются два раздела. В первом разделе
Taskbar Appearance доступны следующие чекбоксы:

� Lock the taskbar – отметив этот пункт, вы потеряете возможность добав$
лять/удалять иконки в quick launch меню, не сможете менять его размер
и местоположение. Зато уберется разграничительная линия между quick
launch меню и основной частью таскбара;

� Auto�hide taskbar – подобный пункт существовал уже в W98, и, отметив
его, вы заставите таскбар уезжать вниз, за пределы экрана, когда курсор
мышки стоит не на нем;

� Keep taskbar on top of other windows – снятие этого чекбокса приведет к
тому, что раскрытые на полный экран окна будут закрывать собой таскбар;

� Group similar taskbar buttons – если подобный пункт отмечен, то не$
сколько копий одной и той же программы группируются в одной кноп$
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ке. Например, если открыто несколько десятков окон IE, то они не рас$
ползаются на несколько рядов, а группируются в одной кнопке и выки$
дываются списком при нажатии на нее;

� Show Quick Launch – показывает/прячет Quick launch.
Второй раздел Notification area:
� Show the clock – включает/выключает отображение часов на таскбаре;
� Hide inactive icons – позволяет прятать неиспользуемые иконки в notifi$

cation area. Нажав на кнопку customize, расположенную рядом, вы смо$
жете просмотреть список иконок, показываемых в этой области, и вы$
брать для каждой из них, должна она показываться всегда, прятаться
сразу или тогда, когда не используется.

Вторая закладка – Start Menu. Всего два пункта, Start menu и Classic start

menu. Что они делают, прекрасно понятно из картинки над ними, которая
меняется при выборе одного или другого пункта. Несколько более интересны
кнопочки Customize напротив каждого из пунктов, но и там все достаточно
понятно и очевидно. Для Start Menu можно настроить размер иконок, сколько
программ будет показываться в списке наиболее часто используемых прог$
рамм, выбрать программы, запускаемые при нажатии на Internet и e$mail, ре$
жим, в котором будут показываться различные элементы меню, определить,
будут ли показываться вообще (Display as link – при нажатии откроется окно,
Display as menu – при наведении мышки выкинет меню, Don’t display item –
вообще не покажет).

Для Classic Start Menu доступны те же опции, что были в W2k, и несколько
новых, из которых стоит отметить пункт, раньше доступный только через
реестр или с помощью различных твикеров, удаление из Start Menu пункта Run.

При открытии папки с рисунками они показываются как картинки. В пер$
вый раз тормозит, потом работает быстро. Где это все кэшируется? И как это
отключить?

Для отключения данной функции достаточно изменить вид отображения
папки в меню View или через соответствующую ему пиктограмму. Сам кэш хра$
нится в той же директории, что и картинки, это системный файл с именем
Thumbs.db.

УУУУУправление пользователями,правление пользователями,правление пользователями,правление пользователями,правление пользователями,

которым можно заходить на компьютеркоторым можно заходить на компьютеркоторым можно заходить на компьютеркоторым можно заходить на компьютеркоторым можно заходить на компьютер
Как любая NT, XP имеет механизм идентификации пользователей, и каждого
пользователя можно ограничить в правах. На этих пользователях и их правах
строится вся модель безопасности XP, как на локальной машине, так и в сети.
Нельзя защитить что$либо паролем, можно определить, какие пользователи
имеют право использовать тот или иной ресурс. Пользователей на одной ма$
шине может быть множество, и, чтобы было проще ими управлять, пользова$
тели разбиты на группы. Управление пользователями и группами осуществля$
ется с помощью апплета Users Accounts в Control Panel. После установки
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системы образуются только два пользователя – один с правами администрато$
ра, который вы создали в процессе установки XP, и Guest, который показан
в окне (на самом деле есть еще несколько пользователей, например пользова$
тель Administrator, но он не показывается в списке, и чтобы залогиниться им,
придется идти на некоторые ухищрения). Если вы обладаете правами админи$
стратора, то можете добавить или удалить пользователя в этом окне, поменять
пароль пользователя или пиктограмму, соответствующую пользователю, а так$
же изменить метод, который используется для входа в систему. Для этого надо
выбрать пункт Change the way users log on and off. По умолчанию стоит Use the
Welcome screen, что означает, что для логона следует всего$навсего кликнуть
по иконке из списка и ввести пароль. Если убрать галочку с этого пункта, то
будет использоваться старый добрый метод входа, знакомый по всем NT, с ок$
ном, в котором предлагается ввести имя пользователя и пароль. Вы не можете
использовать Welcome Screen, если компьютер входит в домейн. Классиче$
ский вход может быть двух видов, с требованием нажать Crtl+Alt+Del и без оно$
го. Для того чтобы это изменить, наберите в любой командной строке control
userapasswords2. Откроется знакомое пользователям W2k окно.

На второй закладке этого окна, Advanced, ставим или снимаем галочку
в чекбоксе Require Users To Press Ctrl+Alt+Delete check box, расположенном
в разделе Secure Logon.

На той же закладке можно нажать кнопку Advanced в разделе Advanced User
Management и запустить хорошо знакомый пользователям предыдущих ОС
линейки NT апплет Local Users and Groups (еще его можно запустить через
Control Panel → Administrative Tools → Computer Management → Local

Users and Groups). Вы окажетесь в хорошо знакомом пользователям предыду$
щих ОС линейки NT апплете, в котором сможете добавить или удалить пользо$
вателей, отредактировать уже существующих, поменять им группу и т. д.

Кроме этого, некоторые настройки для пользователей, такие как время
жизни пароля, конкретные права для различных групп, настраиваются из апп$
лета Local Security Setings из Administrative Tools.

Последнее, что хотелось бы отметить, – это возможность и вовсе отклю$
чить необходимость в вводе пароля. Для этого вновь запускаем control user$
passwords и снимаем галочку c users must enter a user name and password to use
this computer. Теперь пользователь, выбранный в разделе Users for this
computer:, будет логиниться на компьютер сразу, минуя всякие формальности
вроде ввода паролей или кликанья на собственном имени.

Вход под администраторомВход под администраторомВход под администраторомВход под администраторомВход под администратором
Без лишних усилий администратором дают залогиниться только в Safe mode.
Но залогиниться им можно и в нормальном режиме. Самый простой способ –
это не использовать Welcome screen. При обычном входе вводите имя пользо$
вателя (Administrator), пароль и логиньтесь. При использовании Welcome
screen, когда выкинется окно со списком пользователей, дважды нажмите
Ctrl+Alt+Del – и окажитесь в старом добром окне, где сможете ввести имя па$




